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Safety Notes 

  

For your safety when using the Vista, you should pay particular attention to the following types of 

statements in this User’s Manual:   

 General safety instruction that should be observed at all times while operating 

the instrument. 

 Specific safety instruction critical to the type of instrument operation being 

explained in the area of the manual where the caution appears. 

 Additional clarification of instructions, not safety-related. 

 Use of this equipment in a manner not specified by the manufacturer may impair 

the protection afforded by the equipment. 

 Danger of electric shock if liquids are spilled and fire if volatile or flammable 

liquids are spilled.  Use care when measuring liquid samples. 
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CHAPTER ONE 

Setting Up the Vista 
 

Power jack  
o The instrument is supplied with a 12 VDC (5A) power supply.  The power supply is plugged 

into the back of the instrument as shown along with the Ethernet port and the USB port. 

 
Figure 1.  Rear View with Connectors 

 

 

CAUTION 

o Note:  Use only the power cord included with this instrument or a replacement obtained 

from HunterLab.  Be certain that the power cord is in good condition before connecting it. 

 

Power Switch  
o To turn the instrument on, press the rocker switch on the right side of the instrument. 

 
Figure 2.  Rocker Switch 

 

Keyboard and Mouse  

o The Vista works with the following keyboard and mouse: 
o L02-1017-434 Wireless keyboard and mouse kit. 

o To use this accessory, turn the power off.  Plug the keyboard into the USB port on the front of 
the instrument.  Turn the power back on. 

Power 

Ethernet 

 USB 
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Front and Rear USB Connectors  
o There are two USB connectors on the Vista.  The one in the front is typically used for updating 

software, backing up the instrument, saving Jobs and Workspaces.  The USB port on the back 

of the instrument is typically used to connect a printer or a computer to the Vista. 

 

Figure 3. USB Port 

 

Ethernet Port  

o This port is used to connect the Vista to a network with the purpose of sending data (ASCII) to 
a server. 

 

Updating the Essentials Software   

o 1. First determine the version of software to upload on the Vista and download this version to 
a flash drive. Software upgrades are located here at support.hunterlab.com.  

o 2. Turn on the Vista and place the flash drive in USB port on the front of the instrument 
(Figure 3).  

o 3. Exit the software. Go to JOBS> ABOUT and tap the screen 6 times inside the box.  

 

 
Figure 4. Tap here 6x 

 

o 4. Once the Home Screen is displayed, go to Essentials Update. The software will be updated. 

 

USB Data Port 
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Figure 5.  Select Essentials Update 

 

o 5. To return to the operation of the Vista, click on Essentials.  
o 6.  Return to the JOBS> ABOUT screen to verify the software version. 

 

Update 
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CHAPTER TWO 

Taking a Simple Measurement 

 

What is HunterLab Vista & Essentials?  

Vista is a transmittance-only color measuring instrument capable of measuring color and haze of 
transparent and translucent liquid, films, and plaques and transparent extruded or formed blanks. All 
samples will be measured by placing in the transmission compartment, either at the sphere port or 
receptor port. The size and nature of the sample will determine how the sample is presented and the 
type of sample handling device that is deployed. Sample handling will include cuvette, cells, and 
ampules for liquids and film holders for sheets and films. 

 

Connecting the Sensor and Taking a Measurement 
o After unpacking and setting up the instrument, turn on the power using the rocker switch on 

the lower right side. 

o Once inside the software, the main measurement screen is displayed – Color Data Table 

(D65/10).  

 

 
Figure 6.  Measurement Screen 

 

o The instrument is automatically connected and this connection is reported on the status bar.  
Next, the unit must be STANDARDIZED.   

o Press the Workspace icon   and select Standardization.  Select a mode and press 
‘Standardization’ to initiate.  The status will be reported in the lower left screen. 
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Figure 7.  Standardization Parameters 

 

o Main Measurement Screen.  The Color Data Table view  shows the configured Color Scale, 
Color Differences and Indices data for the Standard and Sample measurements in the job. 
The configured Tolerances can be applied to the Job and Pass/Fail results will also be 
displayed. 
 

o To add a product standard, see Chapter Two: Tools.  To change the color scale, etc., see 
Workspace: Color Scales. To add tolerances, see Workspace: Tolerances.  To save these 
setups as a job or output, see Jobs: Data. To change the views, select Views under 
Workspace. 

 

 
Figure 8. Main Measurement Screen 

 

o A long press on the Sample name will show a menu with the following options: 
a) Set as Standard – to set the sample as Standard 
b) Rename – to rename the sample 
c) Delete – to delete the sample. 
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Figure 9.  Changing, Renaming or Deleting a Sample 

 

o A long press on the Standard name will show a menu with the following options: 
a) Rename – to rename the standard, 
b) Delete – to delete the standard. The deleted Standard is reverted back into the samples 

list with its original name. 
c) Hitch – to Hitch the standard. 

 
Figure 10.  Long Press to Rename, Delete or Hitch 
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CHAPTER THREE 

Navigating the Essentials Screen 

 

The Easy Match Essentials Tools and Status features are shown below.   

 

 

 

 

 

 

 

 

 

 

 
 Figure 11.  User Interface Screen for Vista & Essentials 

 

Tools 

 Read 

 

o Samples and Standards are read using this key.  
o This tool can be moved around the screen by pressing and moving the icon. 
o Assigning a Standard is done by pressing and holding the sample number and following the 

onboard instructions. 
 

Tools:  View Flippers 

 

o Switching between Views can be accomplished by using the semi-transparent “Next” and 
“Prev” buttons placed at the side edges of the screen or by swiping left or right with two 
fingers on the screen.  

View Flippers 

Tool Bar 

System Bar 

Sensor 
Status 

Job 
Status 
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Sensor Status: 

o The Vista serial number is shown at the bottom left side of the System Bar and the current 
state of standardization is reported in the same area. 

Jobs Status/Workspace Status: 

o Job/Workspace Status is reported on the bottom right side of the System Bar. 

Tools:  View Options   

 

o This menu shows the configuration options for the active view. 

 

Tools:  Workspace  

 

o The Workspace menu provides color scales, illuminants, indices and difference selections 
and Read Options for measurements.  
 

Tools : Jobs  

 

o A job is a collection of all the data views (displays) and measurements (standards and 
samples) used for a particular task, product, or customer.  Jobs are the “documents” of 
EasyMatch Essentials, analogous to word processing documents containing text and 
formatting.   

o Jobs can be created for many different reasons, such as to hold data for a certain customer 
or a specific product line.  Each operator may maintain their own job with preferences, or 
create separate jobs for different operations.   
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CHAPTER FOUR 

Tool Bar:  Jobs Function 

 

 

 

 

Under the Job function, the following tasks can be accomplished: 

 
Figure 12.  Job Menu 

Jobs 

o Jobs vs. Workspace:  A job consists of standard and samples measured into a specific 
workspace.  A workspace is a template with measurement conditions such as Color 
Scale, Index, illuminant, etc.  There can be only one job open at a time.  A new job will 
use the current loaded workspace settings.  The user can change the settings and these 
changes are applied into the current job.  The last loaded workspace settings are 
applied automatically when the user creates a new job.  The main tool bar provides the 
options to create a new job, open an existing job and save a job. 

Jobs:  New 

o Create a new empty Job.  Select New Job and the current job is replaced with a blank 
screen. 
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Figure 13.  Creating A New Job 

 

Jobs:  Open 

o Open a saved Job. A list of available jobs under the current path are displayed for selection.  
If the job that is needed exists in another folder, then it is an option to change the folder 
(New Folder).  When the job to be opened is displayed select the appropriate button and 
press ‘Open’. 

 
Figure 14.  Open A Job 

 

Jobs:  Save & Save As 

o Save the Job under the desired name.  To save a job, select the folder, name the job and 
save the Job contents into a file.  These files have an ‘.ezm’ extension. 
 

 
Figure 15. Save A Job 
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Jobs:  Print 

o Print an open Job using the parameters set up under Preferences. 

Jobs:  Preferences 

o This menu item shows a dialog box with two pages General & Print as shown below, where 
the General page contains the options to configure. 

 Load the last used workspace and job. 
 Set the Standardization interval. 
 Set the screen brightness. 
 Configure Ethernet for data output. 

 

 
 Figure 16. Jobs> Preferences> General Page 

 Enable Novice Tooltips by checking on the box.    Once enabled, on screen tips can be 
are displayed for 3 seconds.  To display again, roll over the ‘lightbulb icon’ on the lower 
right part of the screen. 

 

 
Figure 17.  Novice Tool tip 
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Figure 18.  Example of Novice Tool Tip 

 

 Enable Application Security.  When this is selected, the application will show the 
login dialog at the application startup.  Valid login credentials are required to 
proceed further.  On successful login, the user name will be shown in the status 
bar.  If ‘Use Last Login Credentials’ is checked, the user will be automatically 
logged in on subsequent startups. 

 

 The Print page allows the user to configure 

 The Readings to print  

 The option to Preview before print.  

 Print report Title and Logo  

 Orientation of the report (Portrait or Landscape) orientation.  

 To save changes, press APPLY. 
 

 
Figure 19.  Job> Preferences> Configure Print Page 

 

Jobs:  Data Management 
o The data contains the standards and sample measurements saved in a Job and database along 

with the sensor information.  The saved measurements are also associated with a respective 
Workspace and Job.   

o The Data Management contains the features to Recall, Import, Export or Email a Job and 
Backup/Restore. 
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 Recall the measurements from the database. 

 Export the Job, Standard and Workspace to a USB flash drive. 

 Import a Job, Standard and Workspace from a USB flash drive. 

 Email the selected Job(s).  

 Backup the Job Files and Database into a USB Flash drive. 

 Restore the Job files and Database from a USB Flash drive. 

 

 
Figure 20.  Data Management Menu 

 

o Jobs:  Data Management :  Recall 

 Recall measurements that have been stored to a job: 

The database contains the standards and sample measurements saved in a Job 
along with the sensor information.  The saved measurements are also associated to 
respective Workspace and Job.   

This feature enables the user to recall the Standard(s)/Sample(s) stored in the 
Database into the current running Job.  

Click Recall option in Data Management, a dialog will be displayed where the user 
can recall the measurements from the database by Selecting the Type: 

 Show Standards associated to a Category 

When this option is selected, the standards list is filled with the standards 
associated with the selected Category (i.e. like Pale Ale) from the Select Standard 
Category list. All of the samples matching are filled into the sample list.  To narrow 
the list, the user can select the samples only associated with the selected standard. 

 Show all the measurements in selected Job 

When this option is selected, the standards list is filled with the standards contained 
in the selected Job from the Select Job drop down list. All of the samples are filled 
into the sample list.  To narrow the list, the user can select the samples only 
associated with the selected standard. 
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 Show the Standards/Samples in the Current Workspace 

When this option is selected, the standards list is filled with the standards 
associated with the current workspace. All of the samples are filled into the sample 
list.  To narrow the list, the user can select the samples only associated with the 
selected standard. 

 Show the Imported Standards 

When this option is selected, the standards list is only filled with the standards 
imported into the database.  

After selecting the measurements click Recall to recall them into the active Job. 

 
Figure 21.  Recall Measurements 

 

o Jobs:  Data Management:  Import This feature allows the user to import the below data from 
a USB flash drive into the instrument.  

 Job file 

 Standard 

 Workspace  
 

 
Figure 22.  Import Data Type 
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 Import Job 

This option allows the user to browse and select a Job file (.ezm) from the USB flash 
drive and import into the instrument. If a file name already exists, then the name 
will be incremented numerically. 

 

 
Figure 23.  Import Job 

 

 Import Standard 

This option allows the user to browse and select a Standard file (extension .std) 
from the USB flash drive and import into the database.  If required, the Standard 
Name can be changed. 

 

 
Figure 24.  Import Standard 
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 Import Workspace 

This option allows the user to browse and select a Workspace file (extension .wsp) 
from the USB flash drive and import into the database.  If the workspace already 
exists, then the user is prompted to specify a different name. 

 

 
Figure 25.  Import Workspace 

 

To use the above functions, a USB flash drive must be present in the port. 

 

o Jobs:  Data Management:  Export. Data can be exported to a CSV file on a flash drive for use 
in Excel or other database program. This feature allows the user to export the below data 
from instrument into a USB flash drive: 

 Job file 

 Standard 

 Workspace  
 

 Export Jobs:  This option allows the user to browse and select an existing Job file 
(.ezm) or the current active Job data and copy into a USB flash drive either in CSV or 
EZM file format. While exporting into EZM format, the current active Workspace 
settings can be applied.  The color data can be saved in a CSV file. 

 

 
Figure 26.  Export Current Job 
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 Export Standard 

This option allows the user to browse and select an existing Standard in the database 
and copy into the USB flash drive as a file (.std). 

 
Figure 27.  Export Standard 

 

 Export Workspace 

This option allows the user to browse and select an existing Workspace in the 
database and copy into the USB flash drive as a file (.wsp).  To use the above functions, 
a USB flash drive must be present in the port. 

 
o Jobs:  Data Management:  Email A Job . Saved data can be emailed if there is an active 

internet connection.  When Mail Job option is clicked, the following screen is shown 
prompting the user to browse and select a user and enter the recipient mail address.  
 

 
Figure 28.  Enter an Address to Email a Job 

 

 Mail Settings 

Click Mail Settings button to configure the SMTP mail server configuration (Port, 
Server) as shown below. The mail settings configuration is mandatory in order to 
enable the mail job feature in the application. When done, press Send.  
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Figure 29.  Enter SMTP Mail Server Information 

 
o Jobs:  Data Management:  Backup/Restore.  The Backup function will copy the entire Vista 

database to a selected folder on a thumb drive.  Restore enables the user to copy the entire 
contents of a thumb drive and upload to the Vista. 

Jobs:  Help 

To access the onboard manual, use Jobs: Help.  Novice Help can also be enabled under Preferences> 
General. 

 

Jobs: About 

The About menu provides information about HunterLab and the current software version. 

 

 
Figure 30.  Job> About the Software 

 

From this menu, the software can be closed by tapping on the screen 6 times. Closing the Essentials 
software, returns you to the Home screen where you can set the Time/Date or return to the Essentials 
software. 
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CHAPTER FIVE 

Tool Bar:  Workspace    

 

Under the Workspace Function, the following tasks can be accomplished: 

 
Figure 31.  Workspace Parameters 

 

Workspace:  ColorScales 

o Color Scales provides four screens in which the Scales, Indices, Differences and 
Illuminant/Observer (Ill/Obs) can be configured. Once selected,  Tolerances and  View 
options can be configured.   

 
Figure 32.  Color Measurement Scales 

o This screen shows the five scales available for measurement.  Select the absolute scale 
(3 parameters) and color difference scales (3 parameters) if needed.  Press Apply and 
begin to read your samples. 

o The Illuminant/Observer screen displays combination selections for these parameters.  
To see all of the choices, you can scroll through the selections by pulling up the screen. 
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Figure 33.  Illuminant/Observer Configuration 

o To select  indices, check the corresponding box on the right side.  Multiple selections 
are avaible.  To see more choices, the screen can be scrolled. 

 
Figure 34.  Indice Configuration 

 

 
Figure 35.  Color Measurement Differences 
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Table 1.  Overview of Color Measurement Parameters for 

EZ View, Color Data Table, Trend Plot & Color Plot 

 

Illuminant Observer Scales Differences Indices View Options 

D65 2/10 CIE Lab dL*a*b* ADMI Pass/Fail1 

C 2/10 CIE LCh dL*C*h* APHA/PtCo/Hazen Tolerances 

F02 2/10 Hunter Lab dXYZ Saybolt Time3 

D50 2/10 XYZ1 dLab Gardner Date3 

D55 2/10 Yxy1 dYxy Haze  

D75 2/10  dE Y Transmittance Trace Range 12 

F07 2/10  dE CMC EBC Trace Range 22 

F11 2/10  dE* 2000 ASBC & Turbidity Trace Range 32 

TL84 2/10  dE* ADMI Trace Range 42 

ULT 30 2/10   ASTM D1500 Auto Range2 

ULT 35 2/10   YI D1925 Display: Line2 

 2/10   YI E313, WI E313 Display: Point2 

    USP, JP Zoom 

    EP Y, GY, R, BY, B Average2 

    EPOP Std. Deviation2 

    NTU Meas per Display2 

1Not Available on Color Plot, 2Trend Plot Only, 3Color Data Table Only 

 

Workspace: Read Options 

o Shows a dialog box to configure options like Averaging, Auto Save, Auto Read, Prompt 
for Standard Category and Read Haze. The Read command performs the operation 
based on the configured options. 
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Figure 36.  Read Options 

 

 Average   

Select the number of readings to average to produce the final measurement. The 
total number of readings to be averaged can be no less than two.  Close the screen 

and press Read to initiate Readings. 

 
Figure 37.  Reading and Averaging 

Once the Read button is pressed, the instrument will display a unique dialog box 
to Read and Average the readings.  The second reading is taken using the dialog 
box button, Read. Once all of the readings are taken, press Average to obtain 
the results. 

 Auto Read    

This feature performs measurements continuously.  In Auto Read mode, 
measurements are initiated and stopped using the Read Button.  The minimum 
value of the Read interval is 1 second and it will read as fast as it can update.  
When in Auto Read mode, the Read Button is enhanced with a checkmark. 
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Figure 38.  AutoRead 

To stop the Auto Read, press the Read button.  

 Auto Save Job  

This selection will automatically save a job.  Once this feature is selected, a 
dialog box will be displayed to name the job. 

 
Figure 39. Auto Save Job 

 

 Prompt for Standard Category 

When this option is selected, the user will be prompted to enter the category 
name to which the standard can be assigned.   

 
Figure 40. Prompt for Standard Category 

A category is a product type (i.e. Pale Ale) to which multiple standards can be 
associated.  This can also be used to Recall a group of standards.  

 Index Bias Correction    

This option allows the user to input a custom slope and intercept correction for 
indices.  The user can select any Index from the list of applicable indices and input 
the desired Gain and Bias values. After selecting the required Indices, select the 
Apply button to save the selected Indices values and update the Views accordingly.  
The Bias-corrected Indices will be marked with * (eg: APHA *10mm) in the 
respective view display. 

To calculate the slope and bias correction, read a series of samples around the 
target values of interest.  Three methods can be used to provide corrected values: 
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1. One standard data point:  In this case, the single data point is compared to the 
expected value.  The Gain remains at 1.0 and the Bias is corrected: 

Bias= Expected Value- Measured Value 
2. Two data points:  In this case, the two readings are compared to the expected 

values. 
Bias Correction=Expected Value 1-(Measured Value 1*Gain) 
Gain Correction= (Expected Value 1-Expected Value 2)/ 
                               (Measured Value 1- Measured Value 2) 

3. Linear regression:  Create a y=mx + b relationship comparing actual readings to 
target values, where target values is on the Y-axis and actual readings are on 
the x-axis.  Enter the slope correction under Gain and the intercept correction 
under Bias. 

 

 
Figure 41.  Slope & Bias Correction 

 

 
Figure 42.  Input Gain & Bias 

 

 Prompt for Sample/Standard Name  
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Select this feature to input the Sample (or Standard) name manually during the 
measurement cycle so that the Sample measurement will be inserted with the 
specified name.  If this option is not selected, the Samples will be inserted with the 
specified default sample name suffixed with the auto incremented index number. 
Press Apply when done. 

 

 
Figure 43.  Prompt for Sample (Standard) Name 

 

Workspace: Tolerances  

o This command can be used to specify the Tolerances, for which are selected in View 
Options dialog box. 

 

 
Figure 44.  Tolerances Configuration 

o Tolerances can be entered manually for a selected scale, index and difference, or can 
be auto-calculated using Auto Tolerance.  Tolerances will be displayed on the 
measurement screen if enabled under the View Options for the Color Data and the 
Color Plot Screens.  Pass/Fail based on these tolerances can be used on the EZ View 
Screen.   
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Figure 45.  Tolerances for Scales 

 

 
Figure 46.  Indices Tolerance Configuration 

 

 
Figure 47.  Difference Tolerance Configuration 

 

 Auto Tolerances are calculated for CMC by considering the values as l:C – 2:1 with 
auto correction factor = 0.75 and commercial factor = 1.  However, these ratios can 
be modified as needed. 
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Figure 48.  Auto Tolerance Configuration 

 

 Once the tolerance parameters are selected, press Apply and then Calculate 
Auto Tolerances.  The calculated tolerances are displayed under the Auto 
Tolerance tab.  If Auto Tolerances are selected, the user cannot manually enter 
tolerances. 

 

Workspace:  Views  

o Views:  This option can be used to select the views to be presented in the application.  
Simply check on the box of the screen needed.  Press Apply to save one or all of the 
screens.  The default screen is the Color Data Table.  To navigate between screens once 
the selections have been applied, use the View Flippers on the left and right of the 
screen.   

 
Figure 49.  Workspace Views 

 

Workspace:  Load Workspace  

o Workspace – A workspace is a collection of user preferred parameters as a template.  
When a user exits Easy Match Essentials and returns, the last used Workspace will be 
loaded if the user has selected that option in Jobs: Preferences.  
 

o Jobs vs. workspace:  A job consists of standard and samples measured into a specific 
workspace.  There can be only one job open at a time.  A new job will use the current 
loaded workspace settings.  The user can change the settings and these changes are 



36 

 

applied into the current job.  The last loaded workspace settings are applied 
automatically when the user creates a new job.  The main tool bar provides the options 
to Create a new job, Open an existing job and Save a job. 

 
o Load Workspace:  When the user selects this button, any previously saved workspace 

can be loaded from the database.  The newly loaded workspace settings will be applied 
to the job and all existing measurements within the job are adjusted accordingly. 

 

Workspace:  Save Workspace 

o The current workspace parameters are saved into a database with a user specified 
name.  Saved workspaces can be moved up to the ‘Switch To’ area if desired by 
dragging and dropping. If no workspaces have been saved, then only default will be 
present. 

 
 

 
Figure 50.  Save Workspace 

 

 
Figure 51.  Load Workspace 

o Note:  When a user exits Easy Match Essentials and returns, the last used Workspace 
will be loaded when the option “Load Last Workspace at Startup” is selected in Job> 
Preferences dialog. 
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Workspace: Standardization  

o Perform a Standardization. From the Workspace menu select Standardization and then 
choose Total or Regular Transmittance for measurement.  For HAZE, select TTRAN and 
check the option “Include Haze”.  Place the samples against the sphere port (TTRAN).   

 Press Standardization, the instrument will initiate a standardization and report the 
status in the system status bar on lower left screen.  

 The Time interval for the re-Standardization can be entered under Jobs>  
Preferences.    

 
Figure 52.  Standardize 

 

Workspace:  User Manager  

o Security can be enabled on the Vista to ensure that operators cannot modify/delete 
folders or files and limit their functionality.  An administrator is identified to set up the 
users/groups with selected privileges.   

o To begin enabling security, go to Jobs> Preferences and enable security on the right 
side.  Then the user is prompted to set up an Administrator account.  The default 
password is ‘hl#123’. 

 
Figure 53.  Enabling Security 
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Figure 54.  Configure Administrator Account 

 

 Once the Administrator has been established, Groups and Users can be assigned 
accounts with limited privileges as shown below. 
  

 
Figure 55.  Create a Group 
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Figure 56.  User Privileges 

 

o When each user logs into the Vista, they must enter a name and password. For 
convenience, the user can check the box under Jobs> Preferences> General to use the 
‘last login credentials’.  
 

 
Figure 57.  Login Credentials 

 

 
Figure 58.  Enable Last Login Credentials 

 
o If needed, the administrative user can delete groups / users and reset passwords of all 

Groups & Users. 
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CHAPTER SIX 

Options (Views) 

 

Views:  EZ View  

o This view provides a simple display of Standard vs. Sample  and Pass/Fail results. 
 

 
Figure 59.  EZ View Display 

o View Options  includes the selection of Pass/Fail.  
 

Views:  Color Data Table  

o The Color Data Table view shows Color Scale, Color Difference, and Index data for the 
Standards and Samples in the job.   

 
Figure 60.  Color Data Display 

 Options such as Tolerances, Pass/Fail, Date and Time, Data Order and Tolerances 
can be selected using the View Options. 
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Figure 61.  Color Data Screen: View Options 

 A long press on the ‘Sample’ can enable the user to make the sample into a 
Standard, change the name or delete the reading.   

 
Figure 62.  Changing a Sample into a Standard 

 To delete a Sample (or Standard), select delete and then confirm the action.   

 
Figure 63.  Delete the Sample Measurement 

 

Views:  Spectral Data Table 

o The Spectral Data Table displays percent transmittance or absorbance values for each 
selected measurement at the wavelengths being measured.   
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Figure 64. Spectral Data Table 

 

 
Figure 65. Spectral Data Table Options 

 

Views:  Spectral Plot  

o This view provides a plot of wavelength vs. spectral measurement parameter.   

 
Figure 66.  Spectral Plot View 

o Press Clear All to remove all the samples to display. Press Select All to enable display of 
all samples. To select an individual sample, click on the respective Sample in the list 
located on the right edge of the screen. 

o Uncheck the option Show Background, to display the plot with white background color. 
o Check Auto Range option to scale the contents to fit into plot.   
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o Note: The Samples List is paginated. Click the left and right arrow buttons below the 
samples list to navigate between pages. 

 

 
Figure 67.  Spectral Plot Options 

 

Views:  Trend Plot 

o This tool can be used to study the trends in production and identify color variations.  
There are four parameters of color measurement (three scale values and optional 
indice) which can be represented in four traces.  If a sample point is selected in one of 
the four traces, it is highlighted in the other 3 traces in blue.  The name is shown at the 
bottom right hand corner of the View.  The Average and Standard Deviation can be 
shown as per the view configuration settings. 

 

 
Figure 68.  Trend Plot 
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Figure 69.  Trend Plot Options 

 

View Options for the Trend Plot  includes the type of display, the statistics and the 
number of readings per display. Continuing with the View Options/Traces, this dialog 
box sets the ranges for the traces or allows selection of Auto Range.  Trace 1 to 3 uses 
the current Color Measurement Scale and Trace 4 will allow for measurement of 
differences or an indice.  The user can select which Traces to view and set control limits 
as a percent. 

 
Figure 70. Trend Plot Traces 

 

Views:  Color Plot  

o This shows the sample location in two-dimensional Color Space with respect to the 
standard for difference measurements or the samples in absolute measurement.  For 
differences, the standard is the center point of the plot and the samples are plotted 
separately on the graph.   

o All of the displayed samples are listed in a list box on the right of the screen. The color 
plot can be zoomed and all of the data points can be viewed in detail.   

o The tolerance plot is available in rectangular and elliptical when tolerances are applied. 
The Pass/Fail sample points are shown in green and red when in difference mode, 
respectively.  In Absolute Mode, they shown in green.  
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Figure 71.  Color Plot View 

 

  
Figure 72. Color Plot Options 
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CHAPTER SEVEN 

Special Measurements 

 

Autoexporting Data through a Direct Connection between Vista and a Computer 

o Materials Needed 
(a) Vista Firmware needed:  1.01.0014 and above 

(b) Hardware needed:  Ethernet cable, Crossover adapter, Ethernet to RS-232 

Connector, RS-232 to USB (optional) 

 
    Figure 73- Ethernet Cable 

 

 
Figure 74- Crossover Adapter 

 

 
Figure 75- Ethernet to RS-232 converter for Connection via Serial port 

 

 
Figure 76- RS-232 to USB converter for connection via USB port 
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o Configure Ethernet to RS-232  
(a) Set up Ethernet to RS-232 adaptor with static IP address and Port Number.  In 

this example, adapter was configured with IP address of 192.168.0.100 and 

port 10001. 

 
o Connect Vista to Computer: 

(a) Plug Ethernet cable (Figure 1) into RJ-45 Ethernet connection at rear of Vista.  

Plug other end of cable into Crossover Adapter (Figure 2). 

 

 
Figure 77.  Rear View of Vista 

 

(b) Plug other end of the Crossover Adapter into Ethernet port of Ethernet to RS-

232 adaptor (Figure 3). 

(c) Plug Ethernet to RS-232 adaptor into serial port of computer (if D-9 serial port 

is present) or into RS-232 to USB converter for connection to USB port.  Plug 

power into Ethernet to RS-232 adaptor. 

 
Figure 78. Cable Configuration for Direct Computer Connection 

o Configure the Vista: (Note:  Requires Essentials Rev 14 or higher) 
(a) Configure the Ethernet port of Vista.   Select Jobs Menu> Preferences and 

Select Config Ethernet.  Enter a valid IP address for the Ethernet port. In this 

example, the following parameters are selected. 

IP Address:    192.168.0.110 
Subnet Mask:   255.255.255.0 
Gateway:     192.168.0.1 
Preferred DNS:   192.168.0.1 
Alternate DNS:   192.168.0.1 

Ethernet Port 
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Figure 79. Configuration Parameters for Ethernet 

 

(b) Press Apply on the Ethernet Configuration and then Apply on the Preferences 

Page to complete. 

(c) Go to Read Options and select Auto Export Measurement using a check and 

select Configure.   

 
Figure 80. Read Options> Auto Export Measurements 

 
(d) For a direct connection between Vista and data collection computer, set up 

the Vista as a Client.   

(e) Set the IP Address to match the settings of the Ethernet to RS-232 converter, 

in this case 192.168.0.100 and the Port as 10001.  Press Apply and then press 

Apply on the Read Options screen to continue. 

 
Figure 81.  Read Options Export 
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(f) Vista is now ready to send data. 

 
o Configure the Computer: 

(a) Connection configurations differ depending on data collection software.  In 

this example, Hyper-terminal is use to demonstrate connectivity.   

(b) The data collection computer will be set up as a Server. 

(c) Connect as follows:  

ii. Select the Comm port that represents the USB or Serial port 

connection. 

iii. Define the Connection: 
Bits per second: 9600 
Data Bits:  8 
Parity:  None 
Stop Bits:  1 
Flow Control:  None 

o Send Data from the Vista: 
(a) Configure the Color Data Table with the color scale and parameters to be 

transmitted. 
i. Standardize the instrument. 

ii. Select Color Scales, Indices & Illuminant/Obs (Workspace> Color Scales) 

iii. Hit Read Button, data will be transferred to the computer. 

 

 
Figure 82. Data Output 

 

The data string is shown as follows: 

<STX><PACKET SIZE>$T<SCALE-LABEL>$T<ill/Obs>$T<LABEL NAME1> 
<$T><VALUE1> $T<LABEL NAME2><$T><VALUE2><$T><LABEL NAME3> 
$T<VALUE3>$T <LABEL NAME N><$T> <VALUE N>$T<CHKSUM><ETX> 
Where,   <STX> is the Start of Text (value =0x02) 

<ETX> is the End of Text (value =0x03) 
$T is the default delimiter.  
<SCALE-LABEL> is the Scale Label (e.g. CIELAB) 
<ill/Obs> is the ill/Obs name (e.g. D65/10) 
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<PACKET SIZE> is the Total size (HEX String) of the Packet excluding the <STX> 
and <ETX> 
<LABEL NAME> is the label name (e.g. L*, a*, b*, dE* etc.) 
<VALUE> is the value for the preceding Label Name 
<CHKSUM> is the Checksum (HEX String) - the sum of all the ASCII values in the 
total packet play load starting from <PACKET-SIZE> and till <CHKSUM>. 

 

Autoexporting Data through an Ethernet Connection 

o Materials Needed 
(a) Vista Firmware needed:  1.01.0014 and above 
(b) Hardware needed:  Ethernet cable plugged into the back of the Vista and the 

other end to a network hub.  Note that the computer must be connected to 
the same network as the Vista. 

 

 
Figure 83.  Ethernet Cable 

 

o Configure the Vista: 
(a) Set up the Vista as the Server.  Go to Read Options and select Auto Export 

Measurement using a check and select Configure.  Choose Vista as Server and 
put Port number as 11111.  
 

 
Figure 84.  Auto Export Measurement 
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(b) To define the data export, go to Jobs> Preferences and Select ‘Config 
Ethernet’. IP Address:  the IP address of the Vista can be determined from the 
on-board Diagnostics program. 

Subnet Mask:   255.255.255.0 
Gateway:   192.168.0.1 
Preferred DNS:  192.168.0.1 
Alternate DNS:  192.168.0.1 

 

 
Figure 85.  Jobs> Preferences> Ethernet Configuration 

 

(c) Press Apply on the Ethernet Configuration and then Apply on the Preferences 
Page to complete. 

(d) The Vista is now ready to send data. 
 

o Configure the Computer Using HyperTerminal Software 
(a) Go to the computer and open HyperTerminal. 

(b) Make a new connection: 

i. Enter a name for the connection 

 

 
Figure 86. Setup for HyperTerminal 
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ii. Connect using TCP/IP(Winsock) 

iii. Enter the Vista IP address and Port Number  

 

 
Figure 87.  HyperTerminal Connection to Vista 

 
o Send Data from the Vista: 

(a) Configure the Vista for the Color Data Screen: 

i. Select Color Scales, Indices & Illuminant/Obs (Workspace> Color Scales) 

ii. Standardize the instrument. (Workspace> Standardization) 

iii. Read sample and view the data on the computer. 

 

 
Figure 88. Data from Vista through Ethernet Connection 
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The data string is shown as follows: 

<STX><PACKET SIZE>$T<SCALE-LABEL>$T<ill/Obs>$T<LABEL 
NAME1><$T><VALUE1> $T<LABEL NAME2><$T><VALUE2><$T><LABEL 
NAME3>$T<VALUE3>$T . <LABEL NAME N><$T> <VALUE 
N>$T<CHKSUM><ETX> 
Where,  <STX> is the Start of Text (value =0x02) 

<ETX> is the End of Text (value =0x03) 
$T is the default delimiter.  
<SCALE-LABEL> is the Scale Label (e.g. CIELAB) 
<ill/Obs> is the ill/Obs name (e.g. D65/10) 
<PACKET SIZE> is the Total size (HEX String) of the Packet excluding 
the <STX> and <ETX> 
<LABEL NAME> is the label name (e.g. L*, a*, b*, dE* etc.) 
<VALUE> is the value for the preceding Label Name 
<CHKSUM> is the Checksum (HEX String) - the sum of all the ASCII 
values in the total packet play load starting from <PACKET-SIZE> and 
till <CHKSUM>. 

 

Haze Measurements 

o First select Haze measurements from the Color Data Screen, using Workspace: Color 
Scales/Indices.   

o Select Standardization: TTRAN and check the box beside Haze. 

 
Figure 89.  Standardization for Haze 

o Install the sample holder needed to measure your samples against the sphere port for 
TTRAN. 

o Read samples using the button on the measurement screen. 

 

Hitch Standard 

o Once a standard is named, it can be changed to a “Hitch” standard.  Hitch 
Standardization is a process by which two or more instruments of similar design can be 
made to read the same color values on a group of specimens.  This process is very 
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useful in expanding the communications of color around the world or between vendor 
and customer. 

o The process of Hitch Standardization (also known as transfer standardization) involves 
assigning one instrument to be the reference, or master, unit and mathematically 
adjusting the secondary, or slave, unit(s) to read the “same” values. In this way, two or 
more instruments can be hitched together. Hitching a secondary unit to a reference 
instrument requires that a specimen be read on both units and the values compared 
and adjusted accordingly. This specimen, known as the hitch standard, is first read on 
the reference instrument and its values recorded as spectral data or colorimetric 
(tristimulus) data. The hitch standard is then physically moved to the secondary 
instrument where it is reread and the values from the reference unit are input into the 
secondary instrument’s processor. 

 
Figure 90.  Hitch Standardization 

 

Tips & Tricks:  Assigning a Standard 

 
Figure 91.  Assigning a Standard 

o To create a standard, select the Set as Standard option.  The system will then ask, “are 
you sure you want to set this sample as standard?”.  If yes, then the sample is renamed 
as Standard. 

o To rename the sample or standard, use the Rename function. 
o To delete the sample or standard, use the Delete function. 
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Tips & Tricks:  Exiting the Software 

o To exit the software, go to Jobs: About.  From within the About screen, you can tap the 
screen six times. 

 
Figure 92.  Exiting Essentials 

o Once in the Home screen, you can change the Date/Time Settings or return to 
Essentials. 

Tips & Tricks:  Recover Unsaved Measurement Data 

o In the case where the application is closed unexpectedly, the data is temporarily stored 
in a table along with the Job details.  When the application restarts, a prompt allows 
the user to recover the data. 

 
Figure 93. Recover Data 

o If the user answers ‘YES’, all measurements are recovered into a new job or appended 
to a saved job. 

 

Protecting the Sphere Port with a Cover Glass 

o The purpose of this is to protect the sphere from chemical vapors.  Inside the 
Transmission Compartment, locate the 3 screws on the cover plate near the sphere.  
Remove the screws, cover plate (1) and the rubber ring (2).  Insert the cover glass (3), 
being careful not to leave fingerprints.  Replace cover plate and ring and secure with 
the screws. 
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Figure 94.  Inserting a Protective Cover Glass 
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CHAPTER EIGHT 

Specifications 

 

The specifications and characteristics of the instrument are given in this chapter.  For best performance, 
the instrument should be placed where there is ample work space with medium or subdued illumination 
and no drafts.  The operating conditions (temperature and humidity ranges) are given in the Operating 
Conditions section below. 

 

Operating Conditions 

 Note:  Do not leave Vista in an area where temperature or humidity extremes are possible. 

Storage Temperature (3weeks) -21°C to 66°C (-5°F to 150°F) 

Operating Temperature 10°C to 40°C (50°F to 104°F) 

Performance Temperature 21-28°C (70-82°F) 

Noncondensing Humidity 10% to 90% 

Standard Accessories 
USB flash drive, Certificate of 
Traceability, Didymium Filter 

 

Physical Characteristics 

Weight 6.35kg (14lbs) 

Dimensions 

(Height x width x length) 

177.8mm x 485.8mm x 228.6mm 

(7in x 19.13in x 9.0in) 

Sample Compartment Height with 
Door closed 

82.55mm (3.25in) 

Communications Interface 1- USB Micro OTG to printer 

2- Wireless mouse and 
keyboard 

3- Ethernet RJ45 for Save, Print 
and Email capability 

Standards Conformance CIE 15:2004, ISO 7724/1, ASTM 
E1164, DIN 5033, Teil 7 and JIS Z 

8722 Condition E, G 

Safety Compliance CE, IEC 61326-1 

System Power 100-240 VAC/1.5A, 47-63 Hz 
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Conditions of Illumination and Viewing 

Light Source Full spectrum LED array 

Dual Beam Spectrophotometer 256 element diode array and high 
resolution, concave holographic 

grating 

Geometry Tt/0° or Td/0° per ASTM  

Sphere  76mm (3in) Spectralon™ 

Port Size/Measured Area 

 

18.5 mm (0.73 in) 
illuminated/9.8mm (0.39in) 

measured 

Transmittance Modes Total (TRAN), Regular (RTRAN), 
Haze 

Transmittance Compartment  

(H x W x D) 

108.0mm x 101.6mm x 187.3mm 
(4.25in x 4.0in x 7.38in); Cover 

can be removed for large 
samples 

 

Instrument Performance 

Spectral Data Range: 400-700 nm 

Reporting Interval (nm): 10 nm 

Spectral Resolution <0.3 nm 

Spectral Repeatability Standard deviation within 0.1 % 

Measurement Pathlength Up to 100mm 

Photometric Range 0-150%  

Measurement Interval <3 seconds 

Measurement Speed (at 23°C) ≤2.5 seconds; 4 flashes 

Inter-instrument Agreement ∆E* ≤ 0.15 CIE L*a*b* (Avg) on 
Transmittance Filter Set; ∆E* ≤ 

0.25 CIE L*a*b* (Max) on 
Transmittance Filter Set 

Colorimetric Repeatability ∆E* ≤ 0.025 on air w/30 readings 
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Measurement 

Data Views Color Data, Spectral Plot, EZ 
View, Tristimulus Color Plot, 

Trend Plot 

Illuminants C, D65, F2, A, D50, D55, D75, 
F07, F11, TL84, ULT30, ULT35 

Observers 2° and 10° 

Color Scales CIE L*a*b*, Hunter Lab, CIE 
Yxy, CIE XYZ and differences 

Color Difference Indices ∆E*, ∆E, ∆E CMC (l:c), ∆E*2000 

Indices and Metrics APHA/PtCo/Hazen, Saybolt, 
Gardner, YI E313 Yellowness, YI 
D1925, ADMI, EBC, ASBC, CIE Y 

Transmittance, USP, EP, JP, 
NTU, EP Opalescence 

Other Hitch Standardization 

Haze 

Data Storage 250 spectral or tristimulus with 
Pass/Fail Tolerances as 

Working, Physical, Numeric and 
Hitch 

Languages Chinese, English, French, 
German, Italian, Japanese, 

Spanish 
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Regulatory Notice 
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CHAPTER NINE 

Features, Accessories & Maintenance 

 

Vista Maintenance & Safety 

The Vista is engineered to be virtually maintenance free.  This section outlines the few parts of the sensor 
that are to be maintained in order for the instrument to function properly. 

o Cleaning the Vista 

The Vista is NOT waterproof, but the exterior of the case may be wiped with a damp cloth. 

o Cleaning the inside of the Vista 

Lift up the light cover to access the transmittance compartment.  The inside may be 
cleaned with a lens brush or with a small amount of soapy water on a lint-free cloth or 
towel.  Note:  Do not spray directly into the instrument chamber. 

o Haze Standard Care  

The Assigned % Haze for this standard is a combination of the surface and internal 
scattering properties of this material.  To maintain the surface properties, it is important 
that the surfaces of this standard are not damaged during normal usage.  If the surface 
is contaminated, a cotton cloth moistened with isopropyl alcohol, or a laboratory glass 
cleaner such as Sparkleen can be used to gently wipe the surface.  After wiping allow to 
dry for a minimum of 60 minutes. 

o Didymium Standard Care 

Check the filter for fingerprints, dust, and other contaminants.  If necessary, gently clean 
the didymium filter with a cotton cloth moistened with Sparkleen.  After wiping allow the 
filter to dry for at least one hour. 

o Power Required 

Voltage:  100-240 VAC,1.5A, 47/63 Hz 
Single Phase 
180 VA maximum 
Fuse:  1.4A, SB 
Installation Category (Over Voltage):  II 

o Safety 

 Do not view the instrument LED’s directly as it may be damaging to the eyes. 

 Do not submerge the instrument in water. 

 Do not take the instrument apart as there are ‘no user serviceable parts’ in the 
instrument. 

 Do not disassemble the instrument and attempt to clean the optical components.  
Do not open the instrument or remove any covers except using the instructions 
given in this User’s Manual or under the direction of HunterLab Technical Support. 
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Verifying Vista Performance 

Testing the Vista for Colorimetric Repeatability: 

o The Repeatability Test assesses how consistently the instrument can measure color.  
Some set up is required and a normal instrument standardization.  Then, twenty 
readings of air are taken.  A table of the difference between the current reading and 
the first reading (Standard) is shown after every measurement.  By entering the 

tolerance, a Pass/Fail assessment is shown.  

When all readings have been made, the final test result is shown. 

1) Setup:   
a. To set up a repeatability test, use the Color Data Table – Workspace> Data 

View> Color Data 
b. Select Workspace> Color Scales – select Color Scale:  CIELab  

                                      Workspace>Color Scales> Illuminant: D65/10  
                                              Workspace>Color Scales> Differences:  dE* 

 

 
                       Figure 95. Set up for Colorimetric Repeatability 

 

 
Figure 96.  Setup for dE* 

 

c. View Options> Select Pass/Fail & Tolerances 
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Figure 97.  Read Options to select Pass/Fail and Tolerances 

 

d. Workspace> Tolerances> Differences – Enter the dE*tolerance of 0.025 
for difference. 

 

 
Figure 98.  Enter Tolerance for dE* 

 

e. Save the Workspace as ‘Repeatability Test’ for later comparison. 

 
2) Standardization:  Workspace> Standardization.  Remove all samples from the 

instrument and standardize in TTRAN on air. 
 

 
Figure 99.  Standardize in TTRAN 
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3) Establishing a Standard:  Read the first sample and make this into a Standard.  
Note:  A long press on the sample name will provide a selection to make this a 
Standard. 

 

 
Figure 100.  Setting a Sample as Standard 

 
4) Readings:  Take 30 samples readings on air and review the Pass/Fail information. 

 

 
Figure 101.  Reviewing 30 Readings 

 
5) Save the Data:  Save the results under Jobs> Save> Repeatability Test_date. 

 

Reading the Didymium Filter on the Vista. 

o The wavelength test allows you to assess readings of the didymium filter that is 
provided with the instrument.  This checks for wavelength accuracy of the 
instrument and should be done on a regular basis (i.e., weekly or bi-weekly) as part 
of your routine instrument performance check. 

a. Setup:  To set up a didymium filter test, use the Color Data and Spectral Data Views 
i. Workspace> Data View> Spectral Data & Spectral Plot 

ii. Select Workspace> Color Scales – select XYZ 
iii. From the Spectral Data Screen> Select Views Options.  Select 430nm as the 

beginning wavelength and 570nm as the end wavelength.  Select difference. 
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Figure 102. Select Spectral Range 

 

iv. Save the Workspace as ‘Didymium Filter’ for later comparison. 

 

b. Standardization:  Remove all samples from the instrument and Standardize in 
RTRAN on air. 

 
Figure 103.  Standardize in RTRAN 

 

i. Place the didymium filter at the lens side of the instrument.  Note:  The 
didymium filter should be clean and free of finger prints.   

ii. Standard:  From the Color Data Screen> Read the first sample and assign 
this sample as a standard by holding a press over the sample name. 

iii. Readings:  From the Spectral Data Screen, Read the filter 20 times 
sequentially.  
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Figure 104.  Difference Spectral Data 

 

iv. Review the d%T Data at 430nm and 570nm and make sure that the 
difference does not vary beyond d%T@430nm ≤1.25 and d%T 570nm ≤2.65 

v. Save the results under Jobs> Save> Didymium Test_date. 
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CHAPTER TEN 

Instrument Replacement, Repair, Problems, and Questions 

 

The following HunterLab policies are described in this chapter: 

 Warranty 

 Shipping claims 

 Returns/service 

 Technical assistance. 

Warranty 

HunterLab warrants that all instruments it manufactures will be free from defects in material and 
workmanship under normal use and service.  Our obligation under this warranty is limited to repairing 
or replacing any parts which our examination discloses to have been factory defective when returned to 
us by prepaid transportation.  The time limit on this warranty is one year from date of shipment of new 
instruments and two months from the date of shipment of repaired instruments. 

HunterLab warranty does not cover expendable items such as lamps, fuses, batteries, and diskettes.  The 
warranty is void if the user has made unauthorized repairs, performed improper installation, or has 
incorrectly used the instrument. 

Shipping Claims 

All materials are sold F.O.B. from Reston, Virginia (unless otherwise specified) and HunterLab 
responsibility ends upon delivery to the first carrier.  All claims for loss or damage must be rendered by 
the consignee against the carrier within fifteen days of receipt of goods.  A copy of this notice must also 
be forwarded to HunterLab within five days of its receipt. 

o Breakage or Damage 

According to the contract terms and conditions of the carrier, the responsibility of the 
shipper ends at the time and place of shipment.  The carrier then assumes full 
responsibility.  Perform the following procedures in the case that your instrument arrives 
broken or damaged. 

 Freight or Express 

1. Notify your local carrier. 
2. Hold the damaged goods with their container and packaging for inspection 

by the examining agent.  Do not return any goods to HunterLab prior to 
inspection by and authorization of the carrier. 

3. File a claim against the carrier.  Substantiate this claim with the examining 
agent’s report.  A certified copy of our invoice is available upon request.  
The original B/L is attached to our original invoice.  If the shipment is 
prepaid, write for a receipted transportation bill. 
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4. Advise HunterLab regarding replacement. 

 Parcel Post Shipment 

1. Notify HunterLab at once in writing, giving details of the loss or damage.  
This information is required for filing a claim. 

2. Hold the damaged goods with their container and packaging for possible 
inspection by postal authorities. 

3. Advise HunterLab regarding replacement. 

 United Parcel Service 

1. Contact your local UPS office regarding damage and insurance claims.  Each 
UPS office has a different method of handling these occurrences and yours 
will advise you of its procedures. 

2. Retain the container and packaging. 
3. Notify HunterLab at once for replacement. 

Shortage 

o Perform the following procedure if your order appears to be missing items. 

 Check the packing list notations.  The apparent shortage may be a backordered 
item and may be marked as an intentional short-ship. 

 Re-inspect the container and packing material, particularly to locate smaller 
items. 

 Ascertain that the item was not removed by unauthorized personnel prior to 
complete unpacking and checking. 

 Notify HunterLab immediately of the shortage in writing. 

Incorrect Shipment 

o Perform the following procedure if material received does not correspond with your 
order. 

1. Notify HunterLab immediately, referencing your order number and item. 
2. Hold incorrect items until return shipping instructions are received. 

Returns for Repair 

A service request order (SRO) number is required before any items can be returned to HunterLab.  
Contact HunterLab’s Order Processing Department to obtain an SRO for damaged or incorrect parts, or 
Technical Support to obtain an SRO to return and instrument for service. 

Do not return any damaged or incorrect items until all shipping instructions are received. 

HunterLab offers complete repair services for all instruments it manufactures.  Call HunterLab for the 
service facility nearest your location.  If your equipment is not functioning properly, contact HunterLab 
Technical Support for maintenance or repair instructions.  Many times, this on-the-spot diagnosis is all 
that is required. 

If repair is required, the instrument may be returned to a HunterLab service facility.  For schedule and 
terms for repairs, call HunterLab Technical Support.  Please read the next section, “When You Need 
Assistance,” prior to contacting HunterLab. 
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Customers are responsible for incoming and outgoing freight charges for instrument returned to 
HunterLab for all repairs, including warranty repairs. 

o Packing and Shipping Instruments for Repair 

Please regard the following instructions when packing your instrument to return it to 
HunterLab for repair.  Please save the original packing to use if needed.  These 
instructions do not replace the recommended professional packaging for your 
instrument, but may assist in eliminating the need for a shipment claim due to faulty 
packaging.  Purchasing freight insurance does not guarantee a successful damaged 
shipment claim if the carrier determines the instrument was not packaged properly. 

 All instrument tiles, black glass, power supply, power cords, and cables for the 
instrument should be included in your shipment.  Your repair estimate will be 
delayed if the instrument tiles are shipped separately later. 

 Cover the measurement port.  Do not use duct tape.  “Painter’s tape” is 
preferred, as it will not leave residue on the instrument. 

 Place the instrument inside original box.  Styrofoam peanuts should not be used 
as packing material for instruments, as they can suspend items weighing only up 
to 5 pounds.  Observe the information listed on the bottom of most cartons 
with regard to burst strength and gross weight limits.  Single wall cardboard 
cartons should not be used.  (A proper packing carton with packing material 
may be purchased from HunterLab, if desired.) 

 Insure the shipment. 

 Provide an itemized packing list of all contents of the shipment. 

 Label the carton(s) as follows: 

HunterLab 

Attn: SRO #____________ 

11491 Sunset Hills Road 

Reston, VA  20190 

U.S.A. 

 

When You Need Assistance 

When you have a problem with an instrument or software, or need technical advice concerning a 
specific application, you may want to consult the support.hunterlab.com webpage.  If you need to 
contact HunterLab for assistance, please have the following information available: 

o The type of sensor for which you need assistance (Vista). 
o The serial number of the instrument (found on the back of the unit). 
o The type of processor or software you are using to access the sensor output (such as 

EasyMatch QC), the version of the software, the operating system, and the brand 
and type of computer, if applicable. 

o The specific nature of the problem, including the exact error message received or the 
number of units the sensor reads “off” from the standard tiles. 

o The steps performed prior to the start of the problem. 
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o Steps already performed to reconcile the problem and/or results of any diagnostic 
tests. 

o The type of product being measured. 
o Environmental conditions under which the instrument is normally used 

(temperature, humidity, dust, fumes, etc.) 
o Whether the instrument has recently been moved or the computer reconfigured. 
o The name(s) of any HunterLab personnel with whom you have previously discussed 

the problem. 

The mailing address for HunterLab headquarters is given below.  Customers outside the United States 
should contact their HunterLab distributor for initial assistance. 

Hunter Associates Laboratory, Inc. 
11491 Sunset Hills Road 
Reston, Virginia  20190 

U.S.A. 
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Assigning a Standard, 56 
Auto Read, 30 
Auto Save Job, 31 
Autotolerance, 34 
Average, 30 
Backup/Restore, 26 
Color Data screen, 12 
Color Data Table, 11, 29, 35, 39 
Color Plot View, 43 
color scale, 12, 15, 39 
ColorScales, 27 
Cover Glass, 57 
Data Management, 20 
Email A Job, 25 
Ethernet Port, 8 
Exiting the Software, 56 
Export, 24 
EZ View, 29, 33, 39, 61 
Haze, 29, 55, 60, 61 
Hitch Standard, 55 
Import, 22 
Index Bias Correction, 31 
Instrument Power, 7 
Jobs, 12, 15, 17, 35, 56 
Keyboard & Mouse, 7 
Load Workspace, 35 
Mail Settings, 25 
Operating Conditions, 59 
Read Options, 29 
Recall, 21 
Sample Name, 32 
Save Workspace, 35 
Sensor Status, 15 
Spectral Data Table, 40 
Spectral Plot View, 41 
Standard Category, 31 
Standardization, 11, 36, 55, 61 
Standardize, 36 
Taking a Measurement, 11 
Tolerances, 12, 27, 33, 40, 61 
Trend Plot, 29, 42, 43, 61 
Updating the Essentials Software, 8 
USB Connectors, 8 
User Manager, 37 
View Flippers, 14, 35 
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View Options, 15, 33, 39, 40, 43 
Views, 35 
Workspace, 11, 12, 15, 21, 27, 35, 36, 55 

 


